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Welcome to SnagIt 
Thank you for your purchase of SnagIt. SnagIt is the premier application to use for all of your screen 
capturing needs. Whatever you can see on your screen, SnagIt easily captures for your immediate use. Once 
you’ve taken your capture, SnagIt lets you edit, enhance, save, and use the capture for numerous tasks. 

This Getting Started Guide will quickly teach you the key concepts for using SnagIt. You will be guided in a 
simple step by step process through the following topics: 
• Taking your first capture. 
• Getting familiar with SnagIt's main user interface and features 
• Capturing with SnagIt 
• Getting familiar with SnagIt's Capture Preview window 
• Exploring the most popular editing and special effects features. 
• Modifying Profile settings 
• Working with Profiles 
• Using SnagIt Editor. 
• Using Catalog Browser. 
This guide is intended to provide you an excellent introduction to SnagIt. Please refer to the SnagIt help file 
for a comprehensive explanation of all the features. 

We hope you enjoy SnagIt. 

 
This Getting Started Guide was created using SnagIt and SnagIt Editor. 
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Taking Your First Capture 
Taking a capture with SnagIt is simple.  Follow these steps to complete and view your capture:   
 

 
 
 

 

 
 

 

Make sure what you want to capture is open on your computer desktop. Without minimizing what 
you want to capture, open SnagIt. 
 

Select a capture profile from the Basic capture profiles. 
 
 

Click Capture. 

 
 

The SnagIt window disappears and you see a box with an explanation of how to complete the 
capture. Follow the instructions to complete the capture. 

 

 Key Concepts 
About the Capture Profile: Many of the most common types of captures have been saved as capture 
profiles and are ready for you to use as soon as SnagIt is installed. Profiles contain a set of capture 
instructions including the mode, input settings, capture options, and more. To choose a capture profile to 
work with, simply click a profile icon. 

The Different Capture Modes: The Capture Mode controls the way that SnagIt captures information. This 
includes the ability to take image, text, video, and Web captures. To choose another Capture Mode, click the 
down arrow next to the Capture button to open the Mode dropdown menu, and then click the desired mode 
in the menu.  
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When complete, the capture appears in the Capture Preview window. Click an output on the Output 
Options toolbar. 

 
Click Done to close the Capture Preview window.  

 

 Key Concepts 
Edit: You can edit your capture in a number of ways. For example, Crop allows you to select a region to 
save while trimming away the rest of the image. Use the Selection tool to drag a region around the portion of 

the capture you want to save. Click on the Crop tool . 

Output Options Toolbar: Use the Preview Window’s various output options on the Output Options toolbar 
to send your capture to any number of outputs “on the fly.” For example, click on the Clipboard option to 
copy this capture to the Windows Clipboard. The default behavior of the Basic capture profiles is to have no 
output selected prior to capture. You can select an output prior to capture by using the Output dropdown 
menu in the Profile settings pane in the SnagIt main interface. 
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SnagIt Main Interface Overview 
SnagIt has an easy-to-use and intuitive interface. Below you will find a basic overview of the different 
components of the Normal view. Basically SnagIt is comprised of capture profiles in the Profiles pane on the 
top and the selected profile’s attributes in the Profile settings pane on the bottom. Once you select a profile, 
simply click the Capture button.  
 

 
 
 
 

 

 

 

 

Capture Profiles in the Profiles pane 
allow you to take a capture quickly. 
Capture profiles are a fast and powerful 
way to configure your capture. All the 
capture settings you see in the Profile 
settings pane make up one profile.  
 

Quick Launch gives access to the SnagIt 
Editor and SnagIt Catalog Browser 
companion applications. 

 
 
 
 

 
 
 
 

 
 

Related Tasks provides easy access to the 
following tasks: Convert images, Turn on 
OneClick, Setup SnagIt printer, and Organize 
profiles. 
 

Profile Settings are updated when a profile 
is selected in the Profiles pane. Customize a 
capture by making changes in the Profile 
settings pane before taking a capture. 
 

Capture Button performs the capture. You 
can also use the default global hotkey which 
is the <Print Screen> key on the keyboard. 
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Capture Profile Properties display in a tool tip. 
Properties include the hotkey, input, output, mode, 
and effects. 
 

Use the Input menu to choose what to capture. To 
access, click Input in the Profile settings pane and 
select the desired option from the menu. Options 
differ according to the Capture Mode selected.  
 

Use the Output menu to choose what happens after 
the capture is taken. To access, click Output in the 
Profile settings pane and select the desired option 
from the menu. Options differ according to the 
Capture Mode selected. 
 

Use Effects to apply special effects during the 
capture process. To access, click Effects in the 
Profile settings pane and select the desired option 
from the dropdown menu. Options differ according 
to the Capture Mode selected. 
 

Options define how the capture looks or if you 
preview your capture before sending it to output. 
Options differ according to the Mode and Input 
selected and may include: ability to capture cursor, 
set timer or delayed capture, capture multiple areas, 
etc. 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 

 
 
 

 

Capture Mode controls the way that SnagIt 
captures information. This includes image, text, 
video, and Web captures. To change the Mode , 
use the dropdown menu next to the Capture 
button. 
 

New Profile allows you to save the current 
settings within the Profile Settings pane as a new 
capture profile. New profiles display within My 
Profiles in the Profiles pane. 
 
 

New Profile Wizard allows you to create a new 
profile from “scratch” by walking you through all 
capture settings. New capture profiles display 
within My Profiles in the Profiles pane. 
 
 

Save Profile allows you to overwrite a selected 
profile with the current settings selected in the 
Profile Settings pane. 
 

List View displays the Profiles in a list. 

 

Thumbnail View displays the Profiles as icons. 
 
 

Organize Profiles displays the Organize Profiles 
dialog box. 
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Capturing with SnagIt 
The primary function of SnagIt is to capture data in many different forms on your system.  
 
There are Five Different Capture Modes in SnagIt 

 

Image 
Capture 

 

SnagIt captures an image of your screen or any portion of it. You can capture 
images of any software application, DirectX games, from scanners, or anything 
else you see on your computer screen. Once captured, you can send the image to 
many outputs including a graphic file, the printer, e-mail, or even a Web server. 

 

Text 
Capture 

 

SnagIt captures the text you see on the screen as editable, ASCII text. SnagIt can 
even save the text in tab delimited format so that it can be easily imported into 
spreadsheets or database applications for sorting and other manipulation. 

 

Video 
Capture 

 

SnagIt records any on-screen activity on your Windows desktop. Capture all your 
mouse movements and application action, and then save the video as an AVI file. 
You can also use SnagIt to create time-lapse video of desktop activity over a 
period of time. 

 

Web 
Capture 

 

SnagIt lets you simultaneously capture all the image, audio, video, and user-
defined file types from a Web site. All you need to do is type in the Web site 
address, choose the number of levels of directories from the root Web address, 
and then choose the file types to include in the search.  

 

Printer 
Capture 

SnagIt captures anything you would normally send to a printer and spools it to an 
image file instead. You do this by printing to the SnagIt 8 Printer from any 
Windows application. Printer Capture settings are accessed by selecting SnagIt 
Printer Capture Settings from the Tools menu in the SnagIt main interface. 

 
These are the Default Capture Profiles 
They are preconfigured for you so you can begin to take captures right away. Each profile has an icon 
associated with it to show you what you will capture using that profile.  
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Below are just a few of over forty different ways SnagIt can capture.  
 

Screen: Capture everything that shows on your 
computer desktop including the cursor if desired. 

Rectangular Region: Capture a rectangular shape 
anywhere on your desktop.  

Window: Capture an application window, dialog 
box, window frame, etc.  

Scrolling Window: Capture the contents of a 
window, including the part not seen. 

Game (DirectX): Capture scenes from DirectX 
games or DirectX media players.   

 
Text: Capture text in tab delimited format to import 
into spreadsheets or database applications. 

 
Object: Capture a specific item on your computer 
desktop such as a button, icon, toolbar, etc.   

 
Menu: Capture dropdown and cascading menus from 
Windows programs.  
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Capture Preview Window Overview 
The Capture Preview window allows you to preview and edit a screen capture before it is sent to an Output. 
Choose from an array of professional quality effects to get just the right look. All Basic capture profiles have 
Output set to Preview Window to allow you to decide what to do with a capture after it is taken. 
For added convenience, many of SnagIt’s most popular and useful effects and tools have been added to a 
handy Tasks Pane located on the right side of the image canvas.  
The Tasks Pane options are accessed by clicking on the active links. Once a link is clicked, if there are no 
settings to configure, the effect will be applied to the capture right away.  
If the option has various settings to select or configure, a related task page will display. Once you have made 
your selections in the task page, click anywhere on the canvas to close the task page and exit back to the 
Tasks pane.  
 

 
 

 

 

 

 

 

 

Done. Click Done to close the Capture 
Preview window. If you have not chosen 
an Output, you will be prompted to save 
the file. 
 

Output Options. On the Outputs toolbar, 
select any tool to perform that output 
operation. Tooltips let you know what 
each tool is. Beneath the Outputs toolbar 
you will find another toolbar containing 
basic editing options such as Crop, Cut, 
Copy, and Paste. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Paint Tools. This is the Paint Tools pane. These 
tools allow you to paint, draw, highlight, add text, 
and more, right on top of your capture. Within the 
Properties pane, enable antialias to give a smooth 
look to your drawing lines or enable drop shadow 
to give your drawing a 3D, professional look. 
Select the color block to change the drawing 
tool’s color. 
 

Tasks Pane. Use the Effects, Size, Color, and 
Action options found in the Tasks pane to enhance 
your captures in an unlimited number of ways. Let 
your imagination run wild and have fun creating!  
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Use the Capture Preview window or SnagItEditor to enhance your captures with professional quality editing 
tools, special effects, stamps, and color adjustments. 
The Tasks pane options are accessed by clicking on the active links. Once a link is clicked, if there are no 
settings to configure, the effect is applied to the capture right away.  
If the option has various settings to select or configure, a related task page displays. Once you have made your 
selections in the task page, click anywhere on the canvas to close the task page and exit back to the Tasks pane. 
Additionally, most of the special effects shown here can be automatically applied during capture through the 
use of a Capture Effect. Select and apply effects within the Profiles settings pane located in the main SnagIt 
interface.  

   
Drop Shadow Fade Edge Torn Edge Wave Edge 

   
Spotlight & Magnify Stamps Annotations Callouts 

    
Perspective & Shear Border Links / Hotspots Watermark 



Getting Started Guide SnagIt  

10   www.techsmith.com 

Modifying Profile Settings  
There will be times when you will want to take a capture and there is not an existing profile to suit your 
needs. Creating a new profile by modifying an existing one is simple and easy to do. Here’s how: 
 

 
Change Capture Profile. In the 
Profiles pane, select Window.   

Add an Effect. In the Profile settings pane, select 
Edge Effect > Drop Shadow Edge from the 
Effects dropdown menu. 

 
Change Output. In the Profile settings 
pane, select Send Mail from the Output 
dropdown menu.  

 
Take Capture. Click the Capture button to begin 
the capture. Move the rectangle around the screen 
to highlight a window. Click with mouse to 
capture.  

 

 Key Concepts 
Unsaved Profile: Once you change any of the settings for a profile, the selected profile has an orange box 
around it and an asterisk next to the profile name.  

The modified profile settings remain “loaded” in the Profile settings pane, even when you complete a capture 
or close SnagIt, until you save the profile, click another profile, or click the modified profile again. The 
orange box and asterisk go away and the profile appears with a blue box again. 
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 Make a Selection. Choose the Selection tool  in the Tools task pane. Choose a shape in the 
Properties task pane and drag an area on the capture. Choose Spotlight & Magnify from the 
Effects task pane. Select the desired Options. 

 
Finish to Send to Output. Click on the Finish button, which will reflect the current output.  

 
Address Mail. Your capture is automatically attached as a PNG file in an email message. 
Address your message as desired and then click Send. 

 

 Key Concepts 
Undo/Redo: Don’t like what you just did? SnagIt gives you the power of an unlimited Undo/Redo feature. 

To undo your steps, click the Undo tool . Did you like that look after all? Click on the Redo tool .  

Spotlight Effect: For an interesting special effect, choose the Freehand Selection tool  and use this to 
outline an object in your capture. Apply the Spotlight & Magnify effect from the Tasks pane. 

Highlight Tool: With the Highlight tool , create focus on your capture using any color. 
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Working with Profiles 
SnagIt Profiles are a very important part of SnagIt and understanding how to use, create, and edit profiles 
allows you to seamlessly fit the process of taking screen captures into your typical work routine.  
Profiles allow you to quickly take a capture using a set of predefined capture instructions which include the 
capture mode, input and output settings, effects, and more. The profiles can be found within the Profiles pane 
on SnagIt’s main interface. You can also easily create and save new profiles.  
We’ll now walk you through how to modify an existing profile’s settings and saving it as a new profile. 
 

 

 

Select a Capture Profile. In the Profile settings pane, click the Region capture profile.  

Notice that the capture settings are loaded into the Profile settings pane and the frame surrounding 
the capture profile is blue.  

 

 

 

Change Output Setting. In the Profile settings pane, click Output to open the Output dropdown 
menu. 

In the Output dropdown menu, click Printer. 
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  Modified Profile. Notice that the frame around the profile turns orange and an asterisk appears next 
to the profile name. 

 Save as a New Profile. Click the New Profile button. The Save Profile As dialog box displays. 

 Choose a Profile Group. In the Save Profile As dialog box, select the group in which to save your 
new profile. By default, the My Profiles group is selected. However, you can select a different 
group, add a new group, or overwrite an existing profile 

 Choose a Name. The Save Profile As dialog box displays. A default name is entered for you. Enter a 
new name, or do nothing to accept the default name. Add a hotkey if desired. Click Save.  

 Save New Profile. Click Save. 
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 Profile is Saved in Profiles Pane. Your new profile is now stored under the selected profile group 
within the Profiles pane. Again, the default is the My Profiles group. 

 Profile Settings Display. Additionally, when the new profile is selected, the settings are updated in 
the Profile settings pane.  

 

 Key Concepts 
Saving as an Updated Profile: You don’t have to save the current settings as a new profile. Click the Save 

Profile button  to save the existing profile with updated capture settings. 

Using your New Capture Profile: To use your new profile, click once on the profile to highlight it. Click 
the Capture button.  

Add New Profile Wizard: This wizard allows you to create a new profile from “scratch” rather than 
modifying and saving an existing capture profile. The wizard walks you through choosing all capture 
settings. Click the New Profile Wizard button  located in the upper right-hand corner the Profiles pane 
on the SnagIt main interface.  
 

Organizing your Profiles: You can change the order of your capture profiles within the Profiles pane. In the 
SnagIt main interface, on the File menu, click Organize Profiles. Use the various options in the Organize 
Profiles dialog box to add a new group, to move captures up or down within the list, or to add a hotkey. 
When finished organizing, click Close. The Profiles pane is updated.  
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SnagIt Editor Overview 
The SnagIt Editor is a great way to edit a screen capture after it is saved to a file since Editor allows you to 
apply professional quality finishing touches to your images without having to take a capture. Editing options 
include flip, reverse, shear, rotate, crop, and cut. Adjust the color depth, add text, or view the frames of a 
video capture. Add custom edge effects such as drop shadow, torn or faded edges, and enhancements such as 
arrows, cursors, lines, text, and much more.  
You will see that SnagIt Editor is very similar in look and feel to the Preview Window. While they are very 
similar, notice the absence of the Done, Finish, and Cancel buttons. Most effects and enhancements are 
available in both the Capture Preview window and SnagIt Editor. 
 

 
 

 

 
 

 
 

 

 

 

File Toolbar Options. Choose from the items 
in the toolbar, like creating or opening an 
image. Tooltips describe each tool. 
Toolbar Options. On the toolbar, click on any 
tool to perform that operation.  
Paint Tools. This is the Paint Tools pane. The 
paint tools allow you to paint, draw, highlight, 
and more in your image.  
Image Viewer. SnagIt Editor has a built-in 
Image Viewer that allows you to quickly view, 
edit, and delete images within a folder without 
having to open each file individually. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Effects. Use the options found in the Effects task pane 
to enhance your captures with special graphic effects, 
such as adding a watermark, border, caption and 
more. 
Size. Use the options found in the Size task pane to 
resize the canvas or image, trim excess canvas, rotate 
the capture, and more. 
Color. Use the options found in the Color task pane 
to enhance your captures with special color effects 
and editing options. Change brightness, apply 
transparency, change to grayscale, and more. 
Action. Use the Links/Hotspots options to create or 
modify links and hotspots in a capture. 
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Catalog Browser Overview 
SnagIt's Catalog Browser allows you to locate, view, and manage captures and multimedia files in thumbnail 
view. The Catalog Browser can view images, text, and .avi files. You can select multiple files to save, 
convert file formats, print, and e-mail in batches.  
 

 
Toolbar. You can access several commonly used options from the toolbar such as the Web Page 
Creator or the Batch Conversion Wizard. Move the mouse across the toolbar to display the tool tips.  

 
Browser Area. Search and select the folder that contains your media files to update them to the 
thumbnail view frame. 

 

 View Thumbnails. Click on the Thumbnail View button  to see visual thumbnails. Click on the 

Detail View button  to see file details in browser format. 

 Viewing Area. The thumbnail images or file details display in this area. The view displayed 
depends upon which view is selected in the toolbar.  

 Preview. A larger view of the selected thumbnail displays in the Preview Area.  
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